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�HIGH-LEVEL DESIGN

CONOPS

Scope

The GPS crypto key identification capability shall provide automated recognition of the key type (weekly, yearly) based on the GPS key only.  The key type shall be determined independent of user defined input and of the short title.  The key type shall be written to the GPS database and shall not be manually changeable by the user.  Automated key type recognition shall be provided for keys transferred via AN/CYZ-10 or manually entered via keyboard.  Key types other than weekly or yearly shall be stored in the database as an “unknown” type and a warning message shall be displayed that the key is not a known type and can not be used by TAMPS.

Applicable Documents

Government Documents

Specifications

SLAM OAG 4 Dec. 1996.

SCP II-5 - “Provide method for TAMPS to independently check the crypto key type and date.”

Standards

None

Other Publications

None

Non-Government Documents

None

Impact Analysis

Mission Planners

It is not envisioned that there will be any impact on the mission planners.

System Administrators

It is not envisioned that there will be any impact on the system administrator.

Database Administrators

The database administrators will be impacted when executing the GPS crypto key applications.  The HMI will be changed to reflect the addition of the unknown key type.  Previously, the HMI only reflected weekly and yearly key types.  An error message will be displayed for key types other than weekly or yearly, and those key types will be stored as an “unknown” type in the database.

Performance and Sizing

The key type determination algorithm will have minimal impact on the time required to load GPS crypto keys.

Operating Locations

The GPS crypto key type identification capabilities will be required at all TAMPS locations: afloat, ashore, training, marine corps expeditionary, DTE/OTE sites, and coast guard bases.

Hardware and Software Configuration

System Hardware

No changes to the currently supported TAMPS configurations are required.

Operating System

No changes to the currently supported TAMPS configurations are required.

Commercial-Off-The-Shelf (COTS) Application Software

No changes to the currently supported TAMPS configurations are required.

Installation

No changes to the currently supported TAMPS configurations are required.

Description of Processing

After the GPS crypto key is transferred via the AN/CYZ-10 or manually entered via the keyboard, the key type will be determined by running a GFI algorithm on the key.  The GPS crypto key will then be stored in the database along with the key type and other crypto key data fields.  Key types other than weekly or yearly will be stored as “unknown”.  TAMPS modules which need to access and utilize GPS receivers will request the appropriate key data from the GPS crypto key server.  The key data (if available) will be provided in response to this request and the module will format the information as required, and include the key in the appropriate BDF.  The BDF will then be transferred to an avionics interface device, such as the memory unit (MU).  The MU will then be used to transfer the BDF, along with the embedded key information into the associated weapon system.

Performance Criteria

This SOR will not have any impact on the TAMPS system performance criteria as specified in the TAMPS TEMP.

System Architecture

Software Architecture

No changes to the current TAMPS software architecture are required.

Hardware Architecture

No changes to the current TAMPS hardware architecture are required.

�Draft User Interface
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Figure � STYLEREF 2 \n �1.2�-� SEQ Figure \* ARABIC \r 1 �1� GPS Crypto Key DBA HMI

	Keys for which the key type cannot be automatically determined will be stored with a key type of “unknown” in the database.  Unknown keys will be listed as ìUNKî in the Type column in the GPS Crypto Key DBA HMI.  Weekly keys will be listed as “CVw” and yearly keys will be listed as “GUV” as in the existing HMI.  There are no other changes to the existing HMI.

�



�

Figure � STYLEREF 2 \n �1.2�-� SEQ Figure \* ARABIC �2� Manual Entry HMI



	The manual entry HMI will include “Unknown” as a new key type.  After the key value is entered twice and the input focus is changed to another field or the OK or Apply button is pressed, the key type will be automatically determined based on the key value.  At that point the key type in the HMI will be updated in the Key Type radio box and will not be editable (read only).

	When the key type cannot be automatically determined, the key will be stored in the GPS crypto key database with a key type of unknown and the error message in � REF _Ref387720465 \* MERGEFORMAT �Figure 1.2-4� will appear.  The start and end date text entry fields will be grayed out if the key type is unknown.

	The label “Zulu” will be added after the start and end date text fields to clarify that the key will be effective at the start of the day Zulu time on the start date until the end of the day Zulu time on the end date.  There are no other changes to the existing HMI.



�



�

Figure � STYLEREF 2 \n �1.2�-� SEQ Figure \* ARABIC �3� Load Keys from DTD HMI



	There are no changes to the existing HMI to load keys from the AN/CYZ-10.  After the OK or Apply button is pressed, the key will be loaded from the AN/CYZ-10.  If the key type cannot be automatically recognized based on the key value the error in � REF _Ref387720465 \* MERGEFORMAT �Figure 1.2-4� will appear.

�



�

Figure � STYLEREF 2 \n �1.2�-� SEQ Figure \* ARABIC �4� Error Message for Unrecognized Key Types



	Upon transfer of a key from the AN/CYZ-10 or manual entry of a key, the key type (weekly, yearly) will be automatically determined and stored.  When the key type cannot be automatically determined, the user will be notified by the message in � REF _Ref387720465 \* MERGEFORMAT �Figure 1.2-4�.  To remove the message the user may either press the “Acknowledge” button or close the dialog box.

�
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Figure � STYLEREF 2 \n �1.2�-� SEQ Figure \* ARABIC �5� Modify Keys HMI



	The modify keys HMI will include “Unknown” as a new key type.  The key type will be retrieved from the GPS crypto key database and will be indicated in the Key Type radio box.  The key type will not be editable (read only).  For unknown key types, the start and end date text entry fields will be grayed out.

	The label “Zulu” will be added after the start and end date text fields to clarify that the key will be effective at the start of the day Zulu time on the start date until the end of the day Zulu time on the end date.  There are no other changes to the existing HMI.



�
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Figure � STYLEREF 2 \n �1.2�-� SEQ Figure \* ARABIC �6� User Interface Hierarchy





�Requirements Trace

RTDB



CS0625.0010�GPS Crypto Key processing shall support automatic recognition and storage of crypto key type (weekly, yearly) based on manually entered data.���CS0625.0020�GPS Crypto Key processing shall support automatic recognition and storage of crypto key type (weekly, yearly) based on data transferred via AN/CYZ-10.���CS0625.0030�Key types other than weekly and yearly shall be stored as “unknown” and a warning indicating that “unknown” key types cannot be used by TAMPS shall be displayed.����

Administrative Actions



Spec Para�RTDB�Action��3.4.1.5.2.2¶1�CS0625.0010

CS0625.0020

CS0625.0030�None.��

Allocation



Spec Para�RTDB�SOF�Functional Unit�User Interface��3.4.1.5.2.2¶1�CS0625.0010�� REF _Ref387804502 \n �1.4.2�a�GST_ManualEntry

GKT_GpsMasterKey���3.4.1.5.2.2¶1�CS0625.0010�� REF _Ref387804502 \n �1.4.2�b�GST_ClientDBA

GST_RequestMgr���3.4.1.5.2.2¶1�CS0625.0010�� REF _Ref387804502 \n �1.4.2�c�GST_DbaGui

GST_ClientDBA

GST_RequestMgr

gpskey/gut�� REF _Ref388410208 \* MERGEFORMAT �Figure 1.2-1���3.4.1.5.2.2¶1�CS0625.0010�� REF _Ref387804502 \n �1.4.2�d�GST_ManualEntry�� REF _Ref388410333 \* MERGEFORMAT �Figure 1.2-2���3.4.1.5.2.2¶1�CS0625.0010�� REF _Ref387804502 \n �1.4.2�e�GST_ManualEntry

GKT_GpsMasterKey���3.4.1.5.2.2¶1�CS0625.0010�� REF _Ref387804502 \n �1.4.2�f�GST_ClientDBA

GST_RequestMgr���3.4.1.5.2.2¶1�CS0625.0010�� REF _Ref387804502 \n �1.4.2�g�GST_DbaGui

GST_ClientDBA

GST_RequestMgr

gpskey/gut�� REF _Ref388410208 \* MERGEFORMAT �Figure 1.2-1���3.4.1.5.2.2¶1�CS0625.0010�� REF _Ref387804502 \n �1.4.2�h�GST_ManualEntry�� REF _Ref388410333 \* MERGEFORMAT �Figure 1.2-2���3.4.1.5.2.2¶1�CS0625.0010�� REF _Ref387804502 \n �1.4.2�i�GST_ModifyDialog�� REF _Ref387720640 \* MERGEFORMAT �Figure 1.2-5���3.4.1.5.2.2¶1�CS0625.0010�� REF _Ref387804502 \n �1.4.2�j�GST_ModifyDialog�� REF _Ref387720640 \* MERGEFORMAT �Figure 1.2-5���3.4.1.5.2.2¶1�CS0625.0020�� REF _Ref387804671 \n �1.4.3�a�GKT_GpsMasterKey���3.4.1.5.2.2¶1�CS0625.0020�� REF _Ref387804671 \n �1.4.3�b�GST_GpsKeyMgr

GST_RequestMgr���3.4.1.5.2.2¶1�CS0625.0020�� REF _Ref387804671 \n �1.4.3�c�GST_DbaGui

GST_ClientDBA

GST_RequestMgr

gpskey/gut�� REF _Ref388410208 \* MERGEFORMAT �Figure 1.2-1���3.4.1.5.2.2¶1�CS0625.0020�� REF _Ref387804671 \n �1.4.3�d�GKT_GpsMasterKey���3.4.1.5.2.2¶1�CS0625.0020�� REF _Ref387804671 \n �1.4.3�e�GST_GpsKeyMgr

GST_RequestMgr���3.4.1.5.2.2¶1�CS0625.0020�� REF _Ref387804671 \n �1.4.3�f�GST_DbaGui

GST_ClientDBA

GST_RequestMgr

gpskey/gut�� REF _Ref388410208 \* MERGEFORMAT �Figure 1.2-1���3.4.1.5.2.2¶1�CS0625.0020�� REF _Ref387804671 \n �1.4.3�g�GST_ModifyDialog�� REF _Ref387720640 \* MERGEFORMAT �Figure 1.2-5���3.4.1.5.2.2¶1�CS0625.0020�� REF _Ref387804671 \n �1.4.3�h�GST_ModifyDialog�� REF _Ref387720640 \* MERGEFORMAT �Figure 1.2-5���3.4.1.5.2.2¶1�CS0625.0030�� REF _Ref387804741 \n �1.4.4�a�GST_ManualEntry

GST_ErrorDialog�� REF _Ref387720465 \* MERGEFORMAT �Figure 1.2-4���3.4.1.5.2.2¶1�CS0625.0030�� REF _Ref387804741 \n �1.4.4�b�GST_GpsKeyMgr���3.4.1.5.2.2¶1�CS0625.0030�� REF _Ref387804741 \n �1.4.4�c�GKT_GpsMasterKey

GST_GpsKeyMgr

GST_RequestMgr���3.4.1.5.2.2¶1�CS0625.0030�� REF _Ref387804741 \n �1.4.4�d�GST_DbaGui

GST_ClientDBA

GST_RequestMgr

gpskey/gut�� REF _Ref388410208 \* MERGEFORMAT �Figure 1.2-1���3.4.1.5.2.2¶1�CS0625.0030�� REF _Ref387804741 \n �1.4.4�e�GST_ManualEntry�� REF _Ref388410333 \* MERGEFORMAT �Figure 1.2-2���3.4.1.5.2.2¶1�CS0625.0030�� REF _Ref387804741 \n �1.4.4�f�GST_ModifyDialog�� REF _Ref387720640 \* MERGEFORMAT �Figure 1.2-5���3.4.1.5.2.2¶1�CS0625.0030�� REF _Ref387804741 \n �1.4.4�g�GST_GpsKeyMgr

GST_ErrorDialog�� REF _Ref387720465 \* MERGEFORMAT �Figure 1.2-4���3.4.1.5.2.2¶1�CS0625.0030�� REF _Ref387804741 \n �1.4.4�h�GST_GpsKeyMgr���3.4.1.5.2.2¶1�CS0625.0030�� REF _Ref387804741 \n �1.4.4�i�GKT_GpsMasterKey

GST_GpsKeyMgr

GST_RequestMgr���3.4.1.5.2.2¶1�CS0625.0030�� REF _Ref387804741 \n �1.4.4�j�GST_DbaGui

GST_ClientDBA�gpskey/gut�� REF _Ref388410208 \* MERGEFORMAT �Figure 1.2-1���3.4.1.5.2.2¶1�CS0625.0030�� REF _Ref387804741 \n �1.4.4�k�GST_ModifyDialog�� REF _Ref387720640 \* MERGEFORMAT �Figure 1.2-5���

Assumptions



Spec Para�RTDB�Assumption��3.4.1.5.2.2¶1�CS0625.0010�The GFI algorithm to automatically recognize the key type will be provided.  The algorithm will be accurate as well as require minimal computational time.  Test keys (weekly, yearly) will be provided which will be recognized by the GFI algorithm.��3.4.1.5.2.2¶1�CS0625.0020�The GFI algorithm to automatically recognize the key type will be provided.  The algorithm will be accurate as well as require minimal computational time.  Test keys (weekly, yearly) will be provided which will be recognized by the GFI algorithm.��3.4.1.5.2.2¶1�CS0625.0030�None���Statements of Functionality (SOF)

Overview

	The automatic recognition and storage of GPS crypto key type (weekly, yearly) will be provided.  The key type will not be editable.  This SOR will not have any impact on the TAMPS system performance criteria as specified in the TAMPS TEMP.

Manually Entered Keys (CS0625.0010)

	a)  TAMPS shall provide recognition of the key type based on the key value for manually entered weekly keys.

	b)  TAMPS shall provide storage of the key type in the GPS crypto key database for manually entered weekly keys.

	c)  TAMPS shall display the key type as “CVw” in the GPS Crypto Key DBA HMI for manually entered weekly keys.

	d)  TAMPS shall update the Manual Entry HMI for manually entered weekly keys to display the key type as weekly.  The HMI will be updated after the key value has been entered twice and the “Key Value (repeat)” text field no longer has input focus.

	e)  TAMPS shall provide recognition of the key type based on the key value for manually entered yearly keys.

	f)  TAMPS shall provide storage of the key type in the GPS crypto key database for manually entered yearly keys.

	g)  TAMPS shall display the key type as “GUV” in the GPS Crypto Key DBA HMI for manually entered yearly keys.

	h)  TAMPS shall update the Manual Entry HMI for manually entered yearly keys to display the key type as yearly.  The HMI will be updated after the key value has been entered twice and the “Key Value (repeat)” text field no longer has input focus.

 	i)  TAMPS shall display the key type as “Weekly” in the Modify Keys HMI for manually entered weekly keys.

	j)  TAMPS shall display the key type as “Yearly” in the Modify Keys HMI for manually entered yearly keys.

Transfer of Keys from AN/CYZ-10 (CS0625.0020)

	a)  TAMPS shall provide recognition of the key type based on the key value for weekly keys electronically transferred from the AN/CYZ-10.

	b)  TAMPS shall provide storage of the key type in the GPS crypto key database for weekly keys electronically transferred from the AN/CYZ-10.

	c)  TAMPS shall display the key type as “CVw” in the GPS Crypto Key DBA HMI for weekly keys electronically transferred from the AN/CYZ-10.

	d)  TAMPS shall provide recognition of the key type based on the key value for yearly keys electronically transferred from the AN/CYZ-10.

	e)  TAMPS shall provide storage of the key type in the GPS crypto key database for yearly keys electronically transferred from the AN/CYZ-10.

	f)  TAMPS shall display the key type as “GUV” in the GPS Crypto Key DBA HMI for yearly keys electronically transferred from the AN/CYZ-10.

 	g)  TAMPS shall display the key type as “Weekly” in the Modify Keys HMI for weekly keys electronically transferred from the AN/CYZ-10.

	h)  TAMPS shall display the key type as “Yearly” in the Modify Keys HMI for yearly keys electronically transferred from the AN/CYZ-10.



Unknown Key Types (CS0625.0030)

	a)  TAMPS shall provide a warning when the key type cannot be automatically  determined (unknown) based on the key value for manually entered keys.  The warning shall indicate that unknown key types cannot be used by TAMPS.

	b)  TAMPS shall provide storage in the GPS crypto key database of manually entered keys for which the key type cannot be automatically determined based on the key value.

	c)  TAMPS shall provide storage of the key type as unknown in the GPS crypto key database for manually entered keys for which the key type cannot be automatically determined based on the key value.

	d)  TAMPS shall display the key type as “UNK” in the GPS Crypto Key DBA HMI for manually entered unknown keys.

	e)  TAMPS shall update the Manual Entry HMI to display the key type as unknown and to gray out the start and end date text fields for manually entered keys for which the key type cannot be automatically determined based on the key value.  The HMI will be updated after the key value has been entered twice and the “Key Value (repeat)” text field no longer has input focus.

	f)  TAMPS shall display the key type as “Unknown” and gray out the start and end date text fields in the Modify Keys HMI for manually entered unknown keys.

	g)  TAMPS shall provide a warning when the key type cannot be automatically determined (unknown) based on the key value for keys electronically transferred from the AN/CYZ-10.  The warning shall indicate that unknown key types cannot be used by TAMPS.

	h)  TAMPS shall provide storage in the GPS crypto key database of keys electronically transferred from the AN/CYZ-10 for which the key type cannot be automatically determined based on the key value.

	i)  TAMPS shall provide storage of the key type as unknown in the GPS crypto key database for keys electronically transferred from the AN/CYZ-10 for which the key type cannot be automatically determined based on the key value.

	j)  TAMPS shall display the key type as “UNK” in the GPS Crypto Key DBA HMI for unknown keys electronically transferred from the AN/CYZ-10.

	k)  TAMPS shall display the key type as “Unknown” and gray out the start and end date text fields in the Modify Keys HMI for unknown keys electronically transferred from the AN/CYZ-10. �

Data Flow Diagram





�

Figure � STYLEREF 2 \n �1.5�-� SEQ Figure \* ARABIC \r 1 �1� Context Diagram



	A context diagram of how this SOR relates to TAMPS is shown in � REF _Ref387720656 \* MERGEFORMAT �Figure 1.5-1�.  This SOR requires the addition of the GPS Crypto Key Type algorithm to automatically determine the key type based on the key value.  The key type algorithm is called by both the GPS Crypto Key Server (for keys transferred from the AN/CYZ-10) and the GPS Crypto Key DBA (for manually entered keys).  This SOR also requires storage in the GPS Crypto Key Database of keys with an unknown key type.  Both the GPS Crypto Key DBA and the GPS Crypto Key Server will be modified to satisfy the requirements of this SOR.



��

Figure � STYLEREF 2 \n �1.5�-� SEQ Figure \* ARABIC �2� Data Flow Diagram for the GPS Crypto Key DBA Application



	The data flow diagram for the GPS Crypto Key DBA application is shown in � REF _Ref387720722 \* MERGEFORMAT �Figure 1.5-2�.  The GPS Crypto Key DBA application is provided for the DBA to manage the GPS crypto key database.  “Key info” refers to information associated with each key including the short title, register number, segment number, instance number, description, start and end effectivity dates, and key type.

	The GPS DBA Manager will send requests to the GPS Crypto Key Server according to what functions the DBA wishes to perform.  The GPS Crypto Key Server returns an error status to the GPS DBA Manager for each request.

	GPS DBA GUI represents the main HMI window for the application.  This window displays the key info retrieved from the server for each key stored in the GPS crypto key database.  The key info displayed in the main HMI for each key in the database is retrieved through a request sent by the GPS DBA Manager to the GPS Crypto Key Server.  The GPS Crypto Key Server will return the key info along with the error status to the GPS DBA Manager, which will send the key info on to the GPS DBA GUI.

	The Modify Keys HMI is displayed when “Modify Keys” is selected from the Edit pulldown menu in the main HMI.  The Modify Keys HMI displays key info received from the GPS DBA GUI for the selected key.  That information may be modified and saved in the GPS crypto key database through the GPS Crypto Key Server.  The key info is sent to the GPS DBA GUI and on to the GPS DBA Manager which sends it along with a request to update a key to the GPS Crypto Key Server.

	The Manual Entry HMI is displayed when “Manual Entry” is selected from the Edit pulldown menu in the main HMI.  The key value entered is sent to the key type algorithm which returns the key type based on the key value.  The key value and key info are sent to the GPS DBA Manager.  The request to store the key along with the key and key info (including the key type) is sent from the GPS DBA Manager to the GPS Crypto Key Server.

	Other requests in response to DBA commands in the GPS DBA GUI which may be sent by the GPS DBA Manager to the GPS Crypto Key Server include key purges, key deletion, and key loads from the AN/CYZ-10.

�

�

Figure � STYLEREF 2 \n �1.5�-� SEQ Figure \* ARABIC �3� Data Flow Diagram for the GPS Crypto Key Server

�	In � REF _Ref387720771 \* MERGEFORMAT �Figure 1.5-3� “key info” refers to the information stored along with the key value which includes the short title, register number, segment number, instance number, description, start and end effectivity dates, and key type.

	The purpose of the GPS Crypto Key Server is to process requests from the GPS Crypto Key DBA application and the MPMs, to store and retrieve GPS crypto keys/key info from the database, and to load keys/key info from the AN/CYZ-10.  The server is started by the operating system during the system boot and should always be running on the TAMPS system.  It consists of a request manager, key manager, AN/CYZ-10 interface, and the key type algorithm.

	The server request manager receives requests from the GPS Crypto Key DBA application.  Requests include updating existing key info in the database (through the Modify Keys HMI in the DBA application), purging all keys/key info from the database, loading keys/key info from the AN/CYZ-10, deleting a key/key info, requesting the key info for each key stored in the GPS crypto key database, and storing keys/key info in the GPS crypto key database (for manually entered keys).  The request manager calls the key manager, which performs the appropriate action.

	For requests to load keys/key info from the AN/CYZ-10, the request manager calls the key manager.  The key manager loads the key values and key info through the AN/CYZ-10 interface from the AN/CYZ-10 using the RS-232/DS-101 standards.  After the key values and key info are loaded, the key values are sent to the key type algorithm which returns the key type.  The key values and key info are then sent to the GPS Crypto Key Server key manager and stored in the GPS crypto key database.  An error status is returned from the key manager to the request manager which sends it to the GPS Crypto Key DBA application.

	For storage of manually entered keys, the request manager receives the key value and key info from the GPS Crypto Key DBA application and sends it to the key manager, which stores it in the GPS crypto key database.  An error status is returned by the key manager to the request manager which sends it to the GPS Crypto Key DBA application.

	For updates to existing keys, the request manager receives the updated key info from the GPS Crypto Key DBA application and sends it to the key manager, which performs the update to the GPS crypto key database.  An error status is returned by the key manager to the request manager which sends it to the GPS Crypto Key DBA application.

	For requests for the key info for each key stored in the database, the server returns the key info associated with each key to the GPS Crypto Key DBA application.  The actual key value is not sent to the GPS Crypto Key DBA application.  The request is received by the request manager which calls the key manager.  The key manager retrieves the key info for each key from the GPS crypto key database and sends it and the error status to the request manager, from where it is sent to the GPS Crypto Key DBA application.

	For key purge and key deletion requests, the request manager receives the request from the GPS Crypto Key DBA application and calls the key manager.  The key manager will perform the necessary action (purging key values/key info or deleting a key value/key info) on the GPS crypto key database and return an error status to the request manager.  The error status is then returned to the GPS Crypto Key DBA application.

	The server request manager receives requests for key values/key info from MPMs.  The MPMs make the requests by key type and date.  The request manager calls the key manager which retrieves the key value and key info from the GPS crypto key database.  The key value, key info, and error status are returned to the request manager and then to the MPM.

�Control Flow Diagram
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Figure � STYLEREF 2 \n �1.6�-� SEQ Figure \* ARABIC \r 1 �1� Control Flow for Keys Transferred Via AN/CYZ-10

�	The control flow for keys transferred via the AN/CYZ-10 is shown in � REF _Ref388169198 \* MERGEFORMAT �Figure 1.6-1�.  The control flows relevant to this SOR for both the GPS Crypto Key DBA and the GPS Crypto Key Server are shown.

	In summary, during normal operation the GPS Crypto Key Server is always executing and waiting for requests.  To load GPS crypto keys from the AN/CYZ-10, it is necessary to invoke the GPS Crypto Key DBA application and to select “Load DTD Keys” from the File pulldown menu.  The “Load Keys from DTD” HMI will be displayed.  When the AN/CYZ-10 is ready to transfer keys, the OK or Apply button in the “Load Keys from DTD” HMI should be pressed.

	At that point the GPS Crypto Key DBA will send a request to the GPS Crypto Key Server request manager to load keys from the AN/CYZ-10.  The server request manager will then call the key manager, which will load the key value and key info from the AN/CYZ-10 using the RS-232/DS-101 interface protocols.

	After the key value and key info have been loaded, the GPS crypto key type algorithm will be executed on the key value to determine the key type.  The key value and key type will then be stored in the GPS crypto key database.

	If the key type was recognized by the key type algorithm, the server will return a status of “no error” to the GPS Crypto Key DBA application.  If the key type was not recognized and therefore classified as unknown, a “key type unknown” error will be returned to the GPS Crypto Key DBA application, at which point the GPS Crypto Key DBA will display a warning indicating that the key type is unknown.
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Figure � STYLEREF 2 \n �1.6�-� SEQ Figure \* ARABIC �2� Control Flow for Manually Entered Keys
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Figure � STYLEREF 2 \n �1.6�-� SEQ Figure \* ARABIC �3� Control Flow for Manually Entered Keys (continued)

�	The control flow for manually entered keys is shown in � REF _Ref388412584 \* MERGEFORMAT �Figure 1.6-2� and � REF _Ref388412594 \* MERGEFORMAT �Figure 1.6-3�.  The control flows relevant to this SOR for both the GPS Crypto Key DBA and the GPS Crypto Key Server are shown.

	In summary, during normal operation the GPS Crypto Key Server is always executing and waiting for requests.  To manually enter GPS crypto keys, it is necessary to invoke the GPS Crypto Key DBA application and to select “Manual Entry” from the Edit pulldown menu.  The “Manual Entry” HMI will be displayed.

	It is necessary to enter the GPS crypto key value in both the “Key Value” and “Key Value (repeat)” fields.  When the input focus is removed (by moving the cursor to another text field or pressing a button other than “Cancel”) from the “Key Value (repeat)” field, the values entered in the two fields will be compared.  If they are not equivalent an error message will be displayed and the “Key Value” and “Key Value (repeat)” fields cleared so that the values may be entered again.

	If the key values in the two fields are equivalent, the GPS crypto key type algorithm will be executed on the key value to determine the key type.  The “Manual Entry” HMI will be updated to indicate the key type.

	If the key type is unknown, a warning will be displayed indicating that the key type is unknown.  For unknown keys, the start date and end date text fields will be grayed out, as the keys will be stored without effectivity dates.

	After the OK or Apply button has been pressed in the “Manual Entry” HMI, the keys in the “Key Value” and the “Key Value (repeat)” fields will once again be compared to make sure they are equivalent, and the GPS crypto key type algorithm executed again on the key value to determine the key type.

	Comparing the key values after the OK or Apply button has been pressed will generate a warning to the user if the first key value (in the “Key Value” field) is changed after the key has already been entered twice.  If the key values are equivalent, the key type algorithm will be executed.  Executing the key type algorithm after the OK or Apply button is pressed increases the reliability of storing the correct key type as the key type is obtained directly from the key type algorithm (instead of from the X/Motif toggle buttons).

	The key value and key type will be sent to the GPS Crypto Key Server along with a request to store the key.  The server will store the key value and key type in the GPS crypto key database and return an error status to the GPS Crypto Key DBA application.

	There are no other changes to the control flow of the GPS Crypto Key Server and the GPS Crypto Key DBA application.
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Figure � STYLEREF 2 \n �1.6�-� SEQ Figure \* ARABIC �4� Control Flow for Key Modification



	� REF _Ref387721008 \* MERGEFORMAT �Figure 1.6-4� shows the control flow when “Edit->Modify Keys” is selected.  The change in this flow is that when the key type is unknown, the start and end date text fields are grayed out.

�Preliminary IDD Information



	There will be no changes to the IDD as a result of this SOR.
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